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Abstrak
Pengembangan media pembelajaran berupa kamus digital menggunakan Microsoft Visual Basic.

Pendahuluan

Microsoft Visual Basic 6.0 adalah sebuah bahasa pemrograman untuk Windows dan
Internet. Sama seperti bahasa pemrograman Basic, Pascal, C dan lain-lain. Tetapi Basic, Pascal dan C
ditujukan untuk sistem operasi Ms-DOS, sedangkan 1Zsual Basic ditujukan untuk sistem operasi

Windows dan Internet.

Jika Anda sudah memahami bahasa pemrograman Basic, maka Zsual Basic sudah lebih
mudah Anda pelajari, sebab sebagian besar perintah-perintah 17sual Basic serupa dengan bahasa

Basic.

Agar Anda dapat menggunakan Microsoft 1'isual Basic 6.0, maka software yang perlu Anda
beli adalah Microsoft Visual Basic 6.0 Enterprise Edition atau Microsoft Visual Basic 6.0 Profesional.
Panduan ini membahas Microsoft Visual Basic 6.0 Enterprise Edition, karena penggunaan software ini

lebih banyak. Peneliti juga menggunakan software ini untuk membuat aplikasi Kamus Digital Fisika.

Kamus Digital Fisika yang telah jadi ini tidak luput dari kekurangan. Bahasan yang akan diulas juga
tidak terlalu detail. Hanya beberapa fasilitas yang dimanfaatkan untuk membuat kamus digital fisika
oleh peneliti. Maka kritik dan saran membangun selalu kami nantikan. Semoga bermanfaat.

Isi
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System Requirements

Agar Anda dapat menggunakan Microsoft Visnal Basic 6.0, maka peralatan-peralatan yang
Anda butuhkan adalah sebagai berikut:

Component Authoring Windows Playback

486DX/66 or SX with

Processor Pentium with floating-point coprocessor . .
floating-point coprocessor

M 16MB minimum 8MB minimum
emo
i 24MB recommended 12MB recommended

System Windows 95, Windows 98, Windows ME, Windows 3.1 or later
software Windows NT 4.0, and Windows N'T 2000 ' \Windows NT 4.0 or later

76MB of free disk space and a CD-ROM

Drive .
drive

Not applicable

Persiapan Rancang Bangun

Sebelum melaksanakan semua kegiatan rancang bangun, sebaiknya kita persiapkan semua
bahan yang diperlukan. Untuk mempermudah dan memperlancar dalam membuat kamus digital
fisika, hal-hal yang harus diperhatikan dan perlu dipersiapkan sebelum membuat aplikasi kamus

digital fisika diantaranya:

1. Buat satu folder khusus untuk memuat semua file atau folder lain yang mendukung aplikasi

kamus digital, misal folder dengan nama S Kamus.
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Gambar 1. Windows Explorer
2. Buat folder BacaData untuk memuat file hasil desain yang berfungsi untuk membaca data.
3. Buat folder CariData untuk memuat file hasil desain yang berfungsi untuk mencari data.

4. Buat folder InputData untuk memuat file hasil desain yang berfungsi untuk memasukkan

data.

5. Buat folder Program untuk memuat file hasil pengubahan file Visual Basic menjadi file

berekstensi EXE., misal CariData.frm menjadi CariData. EXE.
6. Buat folder Setup untuk memuat file aplikasi yang telah dibuat menjadi program Instalasi.

7. Langkah-langkah tersebut di atas akan mempermudah ketika kita memasuki tahap editing

atau pengepakan ke media lain bahkan pemanfaatan secara praktis.

8. Setelah itu kita juga perlu menyiapkan terlebih dahulu file data yang berisi istilah dan

maknanya.

9. Pastikan semua hal yang mendukung kelancaran proses pembuatan media pembelajaran
tidak terlewatkan sedikitpun. Kesehatan dan imajinasi kita juga sangat diperlukan, kalau

perlu rancang ruang kerja Anda senyaman mungkin.
Installasi Microsoft Visual Basic 6.0

1. Masukkan CD Master program Microsoft | isual Basic 6.0 Enterprise Edition.

2. Tunggu beberapa saat sampai muncul kotak dialog di bawah ini, kemudian klik Next.

Komunitas eLearning liImuKomputer.Com 3
Copyright © 2003-2007 llmuKomputer.Com



limuKomputer.Com

ol pewn

lemtallatlon Wizard for Visual Basic 6.0 Enterprise Edi... E

|
| Visual Basic 6.0 Enterprise Edition

e

something in & peswious scieen, chck the Dack button. 'You may cancel the
st allabion al any Lime by chckirg the Exlt bullon.

3 :r«miawwﬂnwwaask .0 Enterprise Edition Flesdme
“Viaw Pleadne

[Hets | Ea |

Gambar 2. Kotak Dialog Installation Wigard

3. Tunggu beberapa saat sampai muncul kotak dialog End User License Agreement di bawah ini,

tandai [ accept the agreement kemudian klik Next.

@ Installation Wizard for Visual Basic 6.0 Enterprise Edi... EI
End User License Agreement

dnscribed i the EULA oxs vl b anknd n tevaw and sihes accept of not
ol the EULA T sl
EULA For pins

o

arvam o Gy, o ke, icrosuf §ses Inamato Ceveen O
Mictersoll o /Fickmond, Wit S8062-6355.

END-USER LICENSE AGREEMENT FOR MICROSOFT SOFTWARE &

IMPORTANT-AEAD CAREFULLY: This Microsct Endilier License
thgreement [TLILA" is o begel agreement wou [esther an
ncivsbual ot 8 singhe eyl snd Mictosah Comorain los the Micsooh

asociatd meds, and panted maters [SOF TWARE PRODUCT ] By
il ciprng. o0 clhennie usig the SOF TWARE PRODUCT of arp [ae
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| dorit accept the agresment
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Gambar 3. Kotak Dialog End User License Agreement

4. Tunggu beberapa saat sampai muncul kotak dialog Product Number and User ID di bawah ini.
Pada kota Please enter your product’s 1D number ketikan nomor seri CD Anda dilanjutkan nama
Anda pada kotak Your name dan nama organisasi atau lembaga Anda di kotak Your company’s

name, kemudian klik Next.
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Gambar 4. Kotak Dialog Product Number and User 1D

5. Pilih Install Visnal Basic 6.0 Enterprise Edition seperti kotak dialog di bawah ini, kemudian
klik Next.

@ [nstallation Wizard for Visual Basic 6.0 Enterprise Edi... E

Visual Basic 6.0 Enterprise Edition

Select Install Visual Basic 6.0 Enterprize Ediion t define an integrated setup
of products and server applications for this warkstation,

Select Server Applications (o skip aver the setup of workstation tools and
go dieclly to server nstallation vptions

@ Install Visual Basic 5.0 Enterprise Edition.

Custom - Server Setup Options
’V " Server Applications

< Back I Mest > I Exit

Gambar 5. Kotak Dialog Select Installation

6. Tunggu beberapa saat sampai muncul kotak dialog di bawah ini, jika Anda setuju dengan

folder yang telah dibuat maka kemudian klik Next.

{8 Installation Wizard for Visual Basic 6.0 Enterprise Edi... 4|
Choose Common Install Folder

Vinusl

ealed Coveren

¥ shown below.

Choase & lokdes for common fler:

C\Propam Fles\Micscsolt Vitusl Stado\Conmon
LY

Dt € has 15653 MS: fien,

< Back Hesd > (2]
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Gambar 6. Kotak Dialog Choose Common Install Folder

7. Tunggu beberapa saat sampai muncul kotak dialog di bawah ini, kemudian klik Continue.

Visual Basic 6.0 Enterprise Setup ﬁ
=
'%!J
; e - e

any open sopkc ont
WARNING: Thes program it ght |
Wi g wilioll Veenaad Blane B [V E rilrspanie on o srgie compriber. Sorme Munaselt products o prosviod
wath which se. din the End User Lic toftware.
Plesie Lok d the Erd User Li A nove. It contand o of the lems and

e e i .
i bt

--------- ot | Bt Sebup

Gambar 7. Kotak Dialog License Agreement

8. Kemudian keluar kotak dialog Product ID maka klik OK.

Yisual Basic 6.0 Enterprise Setup E

Product 10: 82830-111-1111111-39664

Thiz iz pour Microzoft product identification number. If pou want ta call
Microsaft for technical support, pou will be asked for this number.

For your records, please write down this number in the designated portion of
your registration card, After the software has been installed, you can access
the number by clicking the About... command on the Help menu,

Ganbar 8. Kotak Dialog Product ID

9. Dilanjutkan dengan pemilihan tipe instalasi Typical atau Custom. Jika Anda pilih Typical
maka proses instalasi secara umum tapi jika Anda pilih Custorr maka Anda dapat

mengaktifkan beberapa fasilitas pendukung.
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Yisual Basic 6.0 Enterprise Setup

Tao choose the installation you want, click one of the following buttons.

Tupical
@ Setup will install the maost typical companents
=]
@) Custom
@l =
,0"? Setup will allow pou to customize which components ta install
il
Folder.

C:5Pragram FilestMicrosoft Yisual StudiosyBI8 Change Folder..
Exit Setup

Gambar 9. Kotak Dialog Choose Installation

10. Jika Anda memilih tipe Custom, maka akan terlihat kotak dialog seperti di bawah ini. Anda

dapat mengaktifkan semua fasilitas dengan klik Select All, kemudian klik Continue.

Yisual Basic 6.0 Enterprise - Custom

Ity the Options list, select the items you want installed; clear the items pou do not want installed

A grayed box with a check indicates that only part of the component will be installed. To select all components
in the Option list, click Select Al

Dptions: Description;

[ Microsoft Visual Basic 6.0 4B350K. | Data Access Components

v Microsoft Visual SourceS afe 6.0 9926 K.

[ Activer 1941 K

IFd O

v Enterprise Features and Tools 393K

[ Graphics BO41 K Change Dption... ‘
[¥ Tools 1389 K

| Select Al |

Folder for Curtertly Selected Option:

CAWINDOWS \system3Z

Space required on C 111168 K
Space available on C: 1636256 K

LContinue | Cancel ‘

Gambar 10. Kotak Dialog Options List

11. Keluar kotak dialog peringatan tentang VSS. Klik No agar VSS tersedia untuk Visual Basic
5dan 6.

Use the new Visual SourceSa...

‘j The new WSS DE format offers faster performance
! and Label Promation. [t is recommended for new
databazes. When upgrading, choose YES if all
clients have W6 software, athenwize chooze MO to
support both 5 & WE clients with the old DB
format.

Tes Mo
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Gambar 11. Kotak Dialog 1SS

12. Visual Basic 6.0 Enterprise Edition mulai melakukan instalasi. Tunggu hingga selesai 100%.

-
I

Visusl Basie 6.0 Enterprs... 2]

£ R e PR (6

Gambar 12. Kotak Dialog Proses Instalasi

13. Dialog selanjutnya adalah Restart Windows kemudian klik Restart Windows.

Visual Basic 6.0 Enterprise - Restart Win... ﬁ

g “You need ta restart Windows to complete the installation
=

Before you restart, close any open applications. including MS-D0S sessions,
and zave all current dacuments. Remave any floppy disks still inserted in a
disk drive. Then, click the Restart Windows button,

IF you choose ta restart, the screen may go blank or flicker. Please be patient
while Setup restarts your machine.

‘ P ﬁeslalt e | F— ‘

Gambar 13. Kotak Dialog Restart Windows

14. Setelah komputer melakukan Restart Windows, keluar kotak dialog Install MSDN
(Microsoft Developer Network Library). Jika Anda menghendaki proses Instalasi MSDN

dan memiliki CD maka klik Next. Tetapi jika Anda tidak menghendaki maka hilangkan
ceklist pada kotak Install MSDN kemudian klik Next.
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Gambar 14. Kotak Dialog Install MSDN

15. Selanjutnya keluar kotak dialog peringatan seperti di bawah ini. Jika Anda menghendaki

melanjutkan proses instalasi tanpa MSDN maka klik Yes.

(o Installation Wizard for Visual Basic 6.0 Enterprise Edition @

If you exit the Yisual Basic 6.0 Enterprise Edition Installation Wizard before you install MSDN, the online
docurmentation and help system will be unavailable, Do you want to continue withaut installing MSDN?

fes No

Gambar 15. Kotak Dialog Peringatan Instalasi

16. Selanjutnya keluar kotak dialog Server Setups di bawah ini maka langsung klik Next.

“ Installation Wizard for Visual Basic 6.0 Enterprise Edi... [
Server Setups

T et bk,
e e e “eetal” B, N o server kel s o 8 ekt
el et e e e

Sarv Componants
Lo Bk s bronaon wWemd
Vsl Souree ale Serm

< Back. 2]

Gantbar 16. Kotak Dialog Server Setups

17. Selanjutnya keluar kotak dialog Register Over the Web Now! Jika komputer Anda
tersambung Internet, maka dapat langsung registrasi program Anda melalui internet. Jika
tidak tersambung internet maka hilangkan tanda ceklist pada Register Now dan klik

Finish.
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Gambar 17. Kotak Dialog Register Over the Web Now!
Memulai File Baru

Setelah proses instalasi dilakukan dengan sukses, maka kita akan mulai dan menyiapkan semua
perangkat yang dibutuhkan untuk membuat kamus digital fisika. Kita mulai dengan membuka
program Microsoft Visual Basic 6.0 Enterprise Edition. Klik Start > All Programs > Microsoft Visual
Basic 6.0 > Microsoft Visual Basic 6.0.

New Project Eﬁ

?" ﬂ“
I\Wpsoft a Wm

Mew iEKIS \ngl Hecen

» Xk » B N °

Standard EXE  ActiveX EXE  ActiveX DLL Active VB Application
Control Wizard

< < <
SN\
Ze
WB Wizard Data Project 115 Application Addin Ackiver
Manager Document DIl

©

&

|
P 4 = 4 = % |:_i

Cancel |
Help !

™ Dan't show this dislog in the future

Gambar 18. Kotak dialog New Project

Setelah muncul kotak dialog seperti di atas, maka kita pilih Standard.EXE kemudian klik Open.
Untuk menghindari hal-hal yang tidak diinginkan seperti file hilang katena belum tersimpan, maka
kita simpan terlebih dahulu file ke tempat yang kita kehendaki. Misal kita namakan file kerja dengan

nama “InputData” dan disimpan dalam folder InputData.
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Gambar 19. Kotak tampilan Umum

M=%

Pemrograman Database

Database adalah kumpulan data yang disimpan dalam sebuah file atau beberapa file. Untuk

membuat dan mengakses database kita dapat menggunakan DAO (Data Acess Objecr), ADO

(ActiveX Data Object) atau File 10 (File Input Outpud). Kita akan membahas bersama File 10 karena

kita dapat membuat tampilan database sesuai dengan keinginan kita. Sebelum membahas database

dengan File IO, maka kita harus mempelajari kontrol ListView terlebih dahulu. Kontrol List] Gew

adalah sebuah kontrol yang berfungsi untuk melakukan pencetakan ke layar. Cara memasukkan

kontrol List) 7ew adalah sebagai berikut:

1. Klik menu Project kemudian klik Components atau tekan tombol Ctrl+T.

2. Maka akan keluar dialog Components.

Components

Controls | Designers I Insertable Objects I

|| Microsaft Seript Contral 1.0 bl
["IMicrosoft Shell Cantrols And Automation
[CIMicrosaft SysInfo Control 6.0

[_IMicrosaft Tabbed Dialog Control 6.0 (SP3)
[IMicrosoft Tablet PC Type Library, version 1.0
[CImMicrosaft Terminal Services Control Type Librar

[ Microsoft Windows Commen Controls 5.0 {SP2)

Wl Microsoft Windows Commaon Controls 6.0 (SPEfE‘
[ Microsoft windows Comman Controls-2 5.0 (5P

["I Microsaft Windows Comman Controls-2 6,0

["I Micrasoft Windows Comman Controls-3 6.0

["] Microsoft wWinsock Contral 6.0

<) | Bl

—Microsoft Windows Common Controls 6,0 (SP&)

["1M3 Video Contral 1.0 Tvpe Library M Browse... |

[~ Selected Items Only

Location:  C:WINDOWS\system32iMSCOMCTL OCs

ok I Cancel

Apply
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Gambar 20. Kotak dialog Components

3. Carilah ke bawah pilihan Microsoft Windows Common Controls 6.0 kemudian beri

tanda ceklist OK dan klik OK.

4.  Maka semua ikon yang tersedia pada kontrol tersebut akan dimasukkan ke dalam Toolbox.

Yang kita perlukan adalah ikon ListView.

T =
) 5
~

Gantbar 21. Kotak dialog ListV iew
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Membuat Input Data

{iamus Fisika

Gambar 22. Kotak tampilan program Input Data

1. Kita akan merancang form seperti gambar di atas. Kita mulai dari membuka file baru dan

beri nama pada Project? menjadi Kamusku.

F——W Project - kamusku ﬂ
mus - Form orm
1 L EE @
& Form1 =X "E’. gn;;s:: .
T . LB Forml (Formi)
m =}
________________________ properes ko, 34
- o [kamusku Project -
Alphabetic | Categorized |
|(Name) kamusky

Gantbar 23. Kotak dialog form

2. Kemudian klik pada kotak for dan kita lihat pada kotak Properties. Mulai dari Name kita
ganti dari Form1 menjadi FrmInput. Ubah untuk Caption dari form1 menjadi Input Data.
Anda juga bisa mendesain sesuka hati, misal form diberi gambar dengan cara pilih pada

properties Picture dan cari gambar yang Anda inginkan.
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Properties - Forml ﬂ

|F|:|rm1 Farm j
Alphabetic lCategorized ]

(Mame) Form1

AppEarance 1-3D

AutoR.edraw False

Eackolor [ aHaooo000s

Borderstyle 2 - Sizable

(aption Form1

ClipControls True

ControlBiox True

DrawMode 13 - Copy Pen ™

Mo maniThe ol n calid L
(Name)

Returns the name used in code ko
identify an object.

Gambar 24. Kotak dialog Properties Form

3. Selanjutnya kita akan membuat Judul program dengan cara memasukkan Label dan atur
sesuai keinginan Anda. Pada kotak properties Anda dapat mengatur sesuai kebutahan, misal

nama Labell menjadi LblKamus.

Properties - LblKamus &
|LbIKamus Label j
Alphabetic | Categorized ]
(FMame) Lblkarmus ~
Aligrirment 0 - Left Justify
Appearance 1-3D
AutoSize False
BackColor [] aHsoooooor
Biackstyle 0 - Transparent
Biorder Skyle 0 - None
Caption Kamus Digital Fi:
DataField ™
LT e Tt e o et J
Caption
Returnsfsets the text displayed in an
object’s title bar or below an object's

Gambar 25. Kotak dialog Properties Label

4. Kita lanjutkan mendesain bingkai dengan cara memasukkan Frame dan atur sesuai
keinginan Anda melalui kotak properties seperti nama Framel menjadi Frmlstilah dan

FrmMakna.
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Properties - Frmistilah %|
|Femistilah Frame |
Alphabetic lCategorized |
(Mame) Frmlstilah ~
Appearance 1-30
BackCalor [ &+=000000F
EiorderStyle 1 - Fixed Single -
Caption Istilah
ClipControls True
Draglcon {Mone)
Dragiaode 0 - Manual
Enabled True
(= D=k CTmvim bk BAT L
{Mame)
Returns the name used in code ko
identify an object.

Gambar 26. Kotak dialog Properties Frame

5. Masih semangat toh! Mari kita lanjutkan membuat kotak teks. Caranya adalah masukkan
kontrol TextBox kemudian atur sesuai keinginan Anda melalui kotak properties, misal nama

Textl diganti TxtIstilah dan TxtMakna. Ada yang perlu diingat! Pada pilihan Text harus

dikosongkan
Properties - Txtistilah ﬁ
| Tetistilah TextBinx A
Alphabetic Categorized]
TabIndex 3 ~
TabStop True |
Tag
Text
ToolTipText
Top GO0
isible True
virhatsThisHelpID 0
hiidth 9255 I v'
Text
Returns/sets the text contained in the
contral.

Gambar 27. Kotak dialog Properties TextBox

6. Tahap selanjutnya kita akan membuat tombol. Langkahnya adalah memasukkan kontrol
CommandBotton kemudian atur sesuai keinginan Anda, misal nama Command1 menjadi

CmdSimpan, CmdBatal, dan CmdKeluar.
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Properties - CmdSimpan(0) ﬁ

|Emd5impan(l]) CommandButtorj
Alphabetic lCategorized ]

(Mame) CrndSimpan -~

Appearance 1-30 1

EackCalor [ aHso00000F =

Cancel False

Caption Simpan

Causestalidation True

Crefaulk False

DisabledPicture | {Mone)

pounpre o) v
Font

Returns a Font object,

Gambar 28. Kotak dialog Properties CommandButton

7. Kalau semua langkah seudah Anda lakukan, maka saatnya kita uji coba hasil sementara
dengan cara klik menu Run > Start atau tekan tombol F5. Coba masukkan ketikan pada
textbox istilah dan fextbox makna, pastikan dapat berfungsi dengan optimal. Tetapi ketika
Anda mencoba tombol Simpan, Batal, dan Keluar maka tidak akan berfungsi. Hal ini karena

kita belum memberi perintah apa-apa pada masing-masing tombol.

E Input Data Q@Eﬂ

e

_Ramus Digital Feadka,
Datitat

\|

o~y

L

Gambar 29. Kotak tampilan program Input Data

8. Klik ganda pada kotak form Input Data (di tempat yang kosong), kemudian ketiklah

program di bawah ini:

Private Sub Form_Ioad()
End Sub
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9. Kita mulai masuk pada pemberian perintah pada masing-masing tombol. Klik ganda pada

tombol Simpan, kemudian muncul kotak dialog Kode maka ketiklah program di bawah ini:

Private Sub cmdSimpan_Click()

If tlstilah = "" Or xtMakna = "" Then GoTo AdaKosong
Open "DATAKAMUS.DAT" For Append As #1

Write #1, txtlstilah, txtMakna

Close #1

txtlstilah = ""

txtMakna = ""

txtIstilah.SetFocus

Exit Sub

AdaKosong:

Beep

If txtIstilah = "" Then txtIstilah.SetFocus

If txtMakna = "" Then txtMakna.SetFocus
End Sub

10. Tutup kembali kotak dialog Code. Klik ganda pada tombol Batal, kemudian ketiklah

program di bawah ini:

Private Sub ecmdBatal_Click()
txtlstilah = ""

txtMakna = ""
txtIstilah.SetFocus

End Sub

11. Tutup kembali kotak dialog Code. Klik ganda tombol Keluar, kemudian ketiklah program

di bawah ini:

Private Sub cmdKeluar_Click()

pesan = MsgBox("Terima Kasih... Apakah Anda Yakin?", vbInformation +
vbYesNo, "Perhatian")

If pesan = vbYes Then End

End Sub

12. Selesai, simpanlah program Anda dengan nama InputData pada folder InputData.

Sekarang jalankanlah program Anda dan masukkan data sebanyak mungkin. Coba Anda
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cek melalui Windows Explorer, maka sebuah file dengan nama DATAKAMUS.DAT telah
terbuat di folder InputData.

Membuat Baca Data

Views

| ISTILAH
™ |

Usaha Froses perubahan enerpi

v v

Voltmeter Alarukur yang dipunakan untuk .

w W
Wadul Dranau buatan manusia

Wakni Paruh Wakni yang dibumihkan supaya a
Watt Satuan tenaga listok, tenaga yang

b8

z

Oleh : Lilik Setiono

Gambar 30. Kotak tampilan program Baca Data

Setelah file database selesai Anda buat dan telah Anda isi seluruhnya, maka berikut ini adalah cara
membaca isi file. Karena program yang akan Kita buat ini tersimpan di dalam folder BacaData maka

kita perlu meng-Copy file DATAKAMUS.DAT dati folder InputData ke folder BacaData.

1. Rancanglah form seperti di atas, gunakan kontrol ListView untuk membuat kotak

ListViewl. Lihat kembali kontrol List]7ew yang telah kita pelajari di atas.

o Kamusku - BacaData (Form) 0t Femuke x|
- . . =]
o Baca Data L_HE]E = B3 kamusku (Kamusku)
T ] =55 Forms

[3 BacaData (BacaData)

Properties - BacaData 5‘
BacaData Form -

Alphabetic | Categertzed |

(Name) Bacabata ~
Appearance 1-3D
AutoRedraw  Fakse

BackCalor [ =reooo000F

Borderstyle 2 - Sizable

(Caption Baca Data
ClipControls True
ControlBox  True

Drawode 13- Copy Pen [
v

Gambar 31. Kotak dialog form Baca Data
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2. Beberapa langkah sama seperti ketika membuat Input Data. Form dapat diberi gambar
dengan memilih Picture pada kotak properties. Lalu kita tambah bingkai dengan

memasukkan kontrol Frame dan beri nama Frl iew. Atur sesuai keinginan Anda.

3. Setelah itu kita tambah ListView seperti gambar di bawah ini. Untuk memunculkan
kontrol Listl/jew coba Kita baca kembali dari awal. Jika dijalankan maka akan muncul kotak

seperti di bawah ini tetapi belum ada hasil bacaan file data.

= Baca Data _Jokd

Buca Data et ﬁa&x‘

Plleans

Gambar 32. Kotak tampilan program Baca Data

4. Untuk menampilkan data yang telah Kita masukkan, maka kita perlu memberi perintah
kepada program yang Kita buat. Oleh karena itu, klik ganda pada kotak form dan

kemudian muncul kotak dialog Code. Setelah itu ketiklah program di bawah ini:

Private Sub Form_ILoad()

Dim LI As Listltem

Dim Istilah, Makna As String

ListView1.View = IvwReport

ListViewl.Sorted = True

ListView1.GridLines = True

ListView1l.ColumnHeaders.Add , , "ISTILAH", ListView1.Width / 2
ListViewl.ColumnHeaders.Add , , "MAKNA", ListView1.Width / 2
Open "DATAKAMUS.DAT" For Input As #1

Do Until EOF(1)

Input #1, Istilah, Makna

Set LI = ListView1.ListItems.Add(, , Istilah)

LI.Subltems(1) = Makna

Loop

End Sub
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5. Tutup kembali kotak dialog Code dan jalankan program Anda. Jika masih ada kerusakan

atau Error, maka coba Anda teliti program yang Anda tulis. Ketelitan Anda sangat

pengaruh untuk menentukan hasil yang optimal.

Membuat Cari Data

|AM1—‘I-IRI-IMIE'!’IER

Makna
ISTILAH | MakNA
AMPEREMETER ALAT UKUR KUAT ARUS YANG

Gambar 33. Kotak tampilan program Cari Data

Setelah file database dimasukkan melalui program InputData dan diteliti menggunakan program
BacaData, maka selanjutnya kita membuat program akhir yaitu CariData. Program yang Akan kita
buat berupa file CariData dan disimpan pada folder CariData, maka kita perlu meng-Copy file
DATAKAMUS.DAT dari folder InputData ke folder CariData.

1. Rancanglah form seperti di atas, gunakan kontrol ListView untuk membuat kotak

ListViewl. Lihat kembali kontrol List]zew yang telah kita pelajari di atas.

Kamusku ﬂ
~ 08 |a
[ B kemusku (Kemusku)

5 Fams
1 CoriDoka {CarCiatal

Rekumaisets the bet dplared i an
hiect's btin bar or beskow an obiect’s

Gambar 34. Kotak dialog form Cari Data
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2. Beberapa langkah sama seperti ketika membuat Input Data dan Baca Data. Form dapat
diberi gambar dengan memilih Picture pada kotak properties. Lalu kita tambah bingkai

dengan memasukkan kontrol Frame dan beri nama Frm 1 7ew. Atur sesuai keinginan Anda.

3. Setelah itu kita tambah ListView seperti gambar di bawah ini. Tambahkan juga dua buah
tombol yaitu tombol Hapus dan Keluar. Gunakan kontrol CommandBotton dan ganti

nama Command1 menjadi CmdHapus dan CmdKeluar.

& CariData ;@E{

m@mzm%

Gambar 35. Kotak tampilan program Cari Data

4. Untuk menampilkan data yang telah Kita masukkan, maka kita perlu memberi perintah
kepada program yang Kita buat. Oleh karena itu, klik ganda pada kotak form dan

kemudian muncul kotak dialog Code. Setelah itu ketiklah program di bawah ini:

Private Sub Form_ILoad()

Dim LI As Listltem

ListView1.View = lvwReport

ListView1.Sorted = True

ListView1.GridLines = True

ListView1.ColumnHeaders.Add , , "ISTILAH", ListView1.Width / 2
ListViewl.ColumnHeaders.Add , , "MAKNA", ListView1.Width / 2
End Sub

Private Sub CatiData()

Dim Istilah, Makna As String
ListViewl.ListItems.Clear

txtlstilah = UCase("" & txtlstilah & "")

Open "DATAKAMUS.DAT" For Input As #1
Do Until EOF(1)
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Input #1, Istilah, Makna

If UCase(Istilah) Like txtlstilah Then

Set LI = ListView1.Listltems.Add(, , Istilah)
LI.Subltems(1) = Makna

End If

Loop

Close #1

End Sub

5. Tutup kembali kotak dialog Code. Klik ganda TextBox TxtIstilah, kemudian ketik

program di bawah ini:

Private Sub txtlIstilah_KeyDown(KeyCode As Integer, Shift As Integer)
If tlstilah <> "" And KeyCode = 13 Then CariData
End Sub

6. Tutup kembali kotak dialog Code. Klik ganda tombol Hapus, kemudian ketik program di

bawah ini:

Private Sub ecmdHapus_Click()
txtlstilah = ""

txtMakna = ""
txtIstilah.SetFocus

End Sub

7. Tutup kembali kotak dialog Code. Klik ganda tombol Keluar, kemudian ketik program di

bawah ini:

Private Sub cmdKeluar_Click()

pesan = MsgBox("Terima Kasih... Apakah Anda Yakin?", vblnformation +
vbYesNo, "Perhatian")

If pesan = vbYes Then End

End Sub

8. Setelah semua selesai, maka sekarang waktunya menjalankan program Anda. Jangan lupa

Anda menyimpan file CariData pada folder CariData.
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Membuat Program Utama

Gambar 36. Kotak tampilan program Utama

Sebenarnya tidak ada spesial dengan program utama. Hal paling penting adalah modifikasi dari file

CariData menjadi program Kamus Digital Fisika seperti gambar di atas. Ada beberpa hal yang

dapat Kita modifikasi, antara lain sebagai berikut:

1. Kita akan belajar mengubah Icon Form. Agar 17sual Basic 6.0 tersedia gambar-gambar
icon, maka saat isntallasi Anda harus melakukannya secara lengkap. Atau kalau tidak Anda
juga dapat memanfaatkan file-file icon di Windows bahkan Anda dapat membuat icon
sendiri menggunakan software bantuan. Klik kiri satu kali di dalam kotak dialog Form,
kemudian pada kotak dialog properties carilah ke bawah menu Icon. Setelah ketemu, klik-lah
satu kali maka di sebelah kanannya akan muncul sebuah tombol, klik-lah. Tunggu sebentar,

kemudian muncul kotak dialog Load Icon. Pilihlah salah satu gambar yang Anda inginkan,

kemudian klik Open.
Load Icon 2JE3 |
= e — Properties - Form1
Loak i | 3 lcons | « & = B ! X
= st S Formil Form £
[ FrOwWs i haustry [ I iting = -
(S)comm Eamail Alphabetic | categorized |
) Computer Misc Filstyle 1- Transparert| 4 |
I Dragdrop IE0ffice Fonk MS Sans Serif
IJElements 1) Traffic FonkTransparent True
[SFlags EIWingS ForeColor | | &HBDDDDDI;F_!
HasDC Trus
Height 3500
HelpContextlD |0
File name: [ Open I Tcon {Icon)
KeyPreview  False Tl
Files of type:  [lcans [ico7” cul =] Cancel | |l B M)
Hel Icon
_heRE Returns the icon displayed when a

Farmm is minimized &t run ke,

Gambar 37. Kotak dialog Ioad lcon

2. Anda bisa membuat form tidak dapat di-Minimize atau di-Maximize ketika program
dijalankan. Yang tampak dalam form hanyalah tombol Close. Klik kiri di dalam kotak

dialog Form. Pada kotak dialog properties, carilah menu MaxButton, kemudian ubah True
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menjadi False. Jika tombol Minimize juga ingin dimatikan, maka pada menu MinButton

ubah True menjadi False.

r 1
=5 Project1 - Form1 (Form)

|
M y |Form1 Form -1
F#Form1 . :
Alphabetic | Categorized ]
Icon (Icon) A
KeyPreview False B |
Left 7785
LinkMode 0 - Mone
m [ [LnkTopic Form1 =
MaxButton False
MDIChild False
MinBuEEon False
Mouselcon (Icom) Jv 1
B ms smm Clmim b o O Memfeale L J

Mouselcon
Sets a custom mouse icon.

Gambar 38. Kotak dialog Properties Form

3. Anda juga dapat menambah keterangan di masing-masing kontrol. Anda cukup klik kiri
kontrol yang dikendaki kemudian pada kotak dialog Properties cari ToolTipText dan diisi

kata bantu yang Anda inginkan. Misal sebuah tombol diberi kata bantu seperti berikut ini:

Istilah
| Properties - txtIstilah ﬂ
ketik Istilah Yang Dicari!
[bxtTstilah TextBox: =
. Alphabetic | Cateqarized
Ilakna ] l
TabIndex ] A
ISTILAH TahSkop True R |
Tag
< ToolTipText Ketik Istilah va
Wisible True
whatsThisHelpID 0 =
Width 9495 o, |
< w

Gambar 39. Kotak dialog Properties TextBox

4. Untuk mempermudah akses menggunakan tombol, Anda juga dapat menambah fungsi
tombol menggunakan Keyboard. Misal tombol Keluar dapat Anda akses menggunakan
tombol Alt+K. Cara mudah sekali hanya menambahkan & di depan Caption (&Keluar)

seperti gambar di bawah ini:
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Makna
ListView1

X|
|cmdKeluar CommandButton - |
Alphabetic ]Categorized |
(Name) crdkeluar ~
Appearance 1-30 L
EackColor [ aHao000a0F| —
= False
Caption keluar
esyalidation True
Default False
DisabledPicture | {Mone)
DownPicture (Mone) [v]
IR Fhlmmmt

{Name)
Returns the name used in code ko
identify an object.

Gambar 40. Kotak dialog Properties CommandButton

5. Setelah program Anda sukses, selanjutnya program sudah dapat Anda buat menjadi file
EXE agar dapat dijalankan dengan Windows (program dapat dijalankan tanpa Soffware
Microsoft Visnal Basic 6.0 Enterprise Edition). Cara membuat file Aplication adalah klik menu
File > Make project.exe. Ketika file CariData telah Anda modifikasi secara optimal dan

telah disimpan ulang, maka Anda dapat melakukan pengubahan file menjadi EXE.

kS Project1 - Microsoft ¥

Mew Project
[ Open Project...

Add Project..,
Remaove Project

& save Project
Save Praject As...

&P Print...
M@ Frint Setup...

1 CariData.vbp

Exit:

Cirl+h
Cir+O

Save CariData.frm  CirHS
Save CariData.fim As...

Cir+P

Make CariData.exe. ..

Al

File Edit ¥iew Project Format On

Gambar 41. Kotak dialog Make EXE

6. Agar lebih mudah pencarian file selanjutnya, maka file

(CariData.EXE) dan file DATAKAMUS.DAT Kita setukan dalam folder Program.
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i Program
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z (] Baca it 1KB TeotOocument  DS/CHZ007 20:04
& Desirp ! \

= '—""j"‘ Cocuments | [jDaTakaME } 11KB DAT Filo DRTH/Z007 748
My M
&) My Picwres % /s

\
B hy oo \/‘-.___,_-’/
§
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¢ b 3% Floppy (82
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= 3 Skama
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Gambar 42. Kotak tampilan Windows Explorer

Membuat File Setup

| O Accusicr i * ksika o T - - —

{| @ & quran Digtal

@ Gaene g ]

@ etraiar iKamus Fisika

I 0 Maromadia Mfboraara £ ¥
@ Mirosoft Office

@ Microsoft Visual Basic 6.0 L]

(Listrik Dinamis)

T [MAKHA

ol Adcbe Raader 7.0
& Pt Vot
8 Profi vepribacian

3 Ter b Ab-Quran
@ Tomto Sress
B Tursyp Unines 2005

1@ Windows Media Player
) Wincirws Movie Maker
|

Gambar 43. Kotak tampilan hasil instalasi

Setelah program selesai Anda rancang, langkah selanjutnya adalah membuat file Setup agar program
dapat dijalankan pada komputer lain. Sebelum kita membuat file setup, pastikan bahwa program
Anda sudah berjalan dengan baik. Selanjutnya buka kembali program Anda (terutama program
utama yaitu CariData). Jika di dalam program Anda ada perintah untuk membaca drive, hilangkan
nama drive sehingga hanya tersisa nama filenya saja. Pastikan hanya tertulis Open
"DATAKAMUS.DAT" For Input As #1 saja. Pada dasarnya, semua file yang dibutuhkan untuk

menjalankan program yang Anda buat harus berkumpul dengan file utama.

Program yang digunakan Microsoft Visual Basic 6.0 untuk membuat file Setup adalah program
Package and Deployment Wizard yang disertakan dengan Microsoft Visual Basic, sedangkan

Microsoft Visual Basic tidak perlu dijalankan.

1. Agar lebih mudah, satukan terlebih dahulu file-file program Anda ke dalam sebuah folder
(termasuk file-file suara, file-file musik, file-file film serta file-file data jika ada). Yang
dimaksud dengan file-file data adalah *.dat, *.doc, *.txt dan lain-lainnya.
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2. Setelah selesai, klik Start > All Programs > Microsoft Visual Basic 6.0 > Microsoft

Visual Basic 6.0 Tools > Package & Deployment Wizard. Maka akan keluar kotak

dialog seperti gambar di bawah ini:

& Package and Deployment Wizard E

Select project:
[F115 kamus\CariDatal CariData. vbp

Bundle this project info a distributabls package, such as an

Internst cab or & ssbup program,
pprog

package

Send one of this praject's packages to a distribution site, such as
% an Inkermet server,
Deploy

= Rename, duplicate, and delete your packaging and deployment

=) scripts fFor Ehis project.

Manage
Saripks

Close Help

Gantbar 44. Kotak dialog Package and Deployment Wizard

3. Klik Browser, kemudian carilah di mana file program (.vbp) Anda berada, setelah ketemu

klik ganda untuk memasukkan. Setelah selesai klik ikon Package. Akan muncul kotak

dialog seperti di bawah ini. Klik Compile untuk mengkompilasikan program Anda menjadi

file EXE. Anda jangan khawatir karena file .25p Anda tetap ada seperti semula.

Package and Deployment Wizard ﬁ

. Inorder to proceed, the wizard requires the executable file 'CariData, exe’ For
\._‘/ this project. Click Browse to find the file or Compile ta compile the project.

Compile | Cancel |

Gambar 45. Kotak dialog Compile

4. Muncul kotak dialog seperti di bawah ini, isi sesuai keinginan Anda dan klik Next.

|'-;'=ul;nckm and Deployment Wizard - Packagi iﬁ

Choge & packagng s from the kst below.

Backigrg scrpt: . . S
T ——
we | Carcdl et > [ |

Gamtbar 46. Kotak dialog Packaging script

5. Klik Next, setuju dengan pilihan Standart Setup Package.
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Wizard - Package Type E]

husceim the Lypom o fubchage you wirk Lo creste.

tin Ermate & poackage Ut vell be rtabed by &
11 e e,

| ool | ek [Tl ] eemh |

Ganmtbar 47. Kotak dialog Package type

6. Pada kotak dialog Package Folder, ketiklah nama folder untuk penyimpanan file-file Setup
Anda, misal F:¥Setup, kemudian klik Next untuk melanjutkan. Anda dapat memanfaatkan

tombol New Folder untuk membuat folder baru sesuai keinginan Anda.

[, Package and Deployment Wizard - Package Fo... [.J|

hoosm by . ckaon vl be assombled!
d

Bodage folder:
s

f EOTrSEl
isehp

Ganbar 48. Kotak dialog Package folder

7. Muncul kotak dialog seperti di bawah ini, klik Ok. Kemudian kembali ke kotak dialog
seperti di atas dan klik Next.

Package and Deployment Wizard ﬁ

! E & file with this name has already been added to the list of files.

Gambar 49. Kotak dialog Peringatan

8. Kemudian muncul kota dialog seperti di bawah ini. Jika Anda menghendaki menambah

beberapa file maka klik tombol Add.
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CiProgram FlesiHcrosoll Vit w
>
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Gambar 50. Kotak dialog Included Files

9. Jika Anda akan mendistribusikan program Anda dalam disket, maka pilih Multiple Cabs.

Tetapi jika Anda akan mendistribusikan program menggunakan CD-ROM, pilih Single

Cab. Setelah itu klik Next untuk melanjutkan.

‘i Package and Deployment Wizard - Cab Options |

your

‘size oo larger than the diks you plan Lo use, Choose the
sppenprate: option beloe.

Cab options

* Sngie cab.

 iole cabs
b S8

nee | concel | apek [CHeEs )| mesh |

Gambar 51. Kotak dialog Cab options

10. Pada kotak Installation title, ketiklah judul untuk instalasi program Anda. Setelah selesai,

klik Next untuk melanjutkan.

“sPackage and Deployment Wizard - Installation... [

Eniter the bt

[ramus Fea

- s | _cws [ o |

Gambar 52. Kotak dialog Installation title

11. Keluar gambar di bawah ini, kemudian klik Next untuk melanjutkan.
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[ Package and Deployment Wizard - Start Menu... 3|

Gambar 53. Kotak dialog Start Menu Items

12. Muncul gambar di bawah ini, klik Next.

Z}Package and Deployment Wizard - Install Luca...ﬁ

“ou can madify the install location For each of the files listed
bellow by changing the macro assigned to the file in the table, IF
desived, you can add subfolder information to the end of 2
macra, a5 in ${ProgramFiles)\MySubFolder,

Choose the file you wank to modfy, then changs the
information in the: Inskall Location column,

Files:

Hame | Souree | mnstall Location -

Baca Alu bxt FilS KamusiCarData §(AppPath)

Caribatasexe FilS KamusiCarData §(AppPath)

ce.dpg FilS KamusiCarData §(AppPath)

DATAKAMUS.DAT  Fi\S KamusiCarData  $(AppPath)

depag!.jpg FilS KamusiCarData  §(AppPath)

MSCOMCTLOCK | C:UNINDOWS!sustem32 | $(inSvsPath) hd|
wep | Cancel | <pack Ensh |

Gambar 54. Kotak dialog Install Location

13. Klik Next ketika muncul gambar dialog di bawah ini.

4y Package and Deployment Wizard - Shared Files ﬁ

When this package is installed, the folloving Flei(s) can be
installed as shared files. Shared files may be used by more than
one program, They are only remaved If every program which

uses them is removed, Check the files you want to install as
share:

shared files:
[ Hame | Souree | Install Lo
[Jaca Aku.txt Fii5 KamusiCariData  §{AppPath
Ocaribata.exe FiiS KamusiCariData  ${AppPath
Oceipg Fii5 KamusiCariData  4{AppPath
DCIDATAKAMUS.DAT  Fiis KamusiCariData  ${AppPath
O depaat.jpg F:i5 KamusiCariData $(»ﬂppPathliI
< m e
Help | cancel | < Back Erish |

Gambar 55. Kotak dialog Shared files

14. Klik Finish untuk mengakhiri. Maka file-file Setup akan mulai dibuat, sabarlah menunggu

hingga selesai.
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ZiPackage and Deployment Wizard - Finished! E

The wizard has finished collecting information needed to build
this package, Enter the name under which to save the settings
or this session, then ciick Finish to create the package.,

Seripk name:
Jkamus Fisika
wep | Cancel | <Back | men o |

Gambar 56. Kotak dialog Script name

15. Setelah selesai keluar dialog di bawah ini maka klik Close. Laporan hasil pengepakan yang
Anda lakukan. Kemudian kembali ke kotak dialog awal dan klik Close.

=% CariData.vbp - Packaging ... - | O/E3

The cab file For your application has been buil: as
'f\Setupl CariData. CAR'.

There is also a batch file in the support directory
(F:\9etupt SupportiCariDats, BAT) that will allow yvou to recreate the cab
File: in case you make changes to some of the Files.

Save Repork lose

Gambar 57. Kotak dialog Report

16. Sekarang cobalah buka file-file Setup yang baru saja selesai kita buat. Dalam contoh ini,
file-file Setup disimpan dalam F:¥Setup. Hal ini sesuai dengan nama folder yang Anda
buat. Tampilan dalam Windows Explorer adalah sebagai berikut:
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Gambar 58 . Kotak tampilan Folder Setup

Cara Instalasi Program
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Kamus Fisika Setup

Gambar 59. Kotak dialog Instalasi Kamuns

Setelah file-file Setup selesai kita buat, sekarang program sudah dapat Kita Install dengan

cara klik ganda pada file Setup.exe (bergambar komputer) yang berada di dalam folder Setup.
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O back - § | 2 search [ roiters | [
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Gambar 60. Kotak tampilan Windows Explorer

Ketika program Anda sudah ter-install, folder default yang terpasang adalah Projectl.
Sehingga apabila pengguna tidak mengubah nama folder pada saat instalasi, maka program akan
di-install ke dalam folder ini, misal C:¥Program Files¥Projectl. Anda bisa mengubah nama
folder ini sesuai dengan keinginan Anda, sehingga apabila pengguna tidak mengubah nama folder
pada saat instalasi, maka folder yang terpasang adalah folder yang Anda buat. Cara mengubahnya
adalah dengan membuka file SETUPLST pada folder Setup menggunakan NOTEPAD.
Kemudian cari baris DefaultDir=$(ProgramFiles)¥Projectl. Kalau sudah ketemu, gantilah
Project? menjadi nama kesukaan Anda, misal Kamus Fisika. Simpan dan tutup kembali program

Notepad.

Komunitas eLearning liImuKomputer.Com 32
Copyright © 2003-2007 llmuKomputer.Com



IImuKom_puter._Com

Gambar 61. Kotak tampilan Notepad

Cara Membuat Autorun
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Gambar 62. Kotak tampilan Notepad

Setelah file-file setup selesai Anda cek dan diuji coba instalasi, maka saatnya pengepakan ke
dalam CD-ROM. Tapi Anda harus membuat file Autorun agar ketika CD-ROM dimasukkan ke
dalam CD Drive secara otomatis file setup langsung tampil di layar. Caranya adalah Anda cukup
mengetikan [AutoRun] OPEN=setup.exe dan disimpan dengan nama Autorun.INF, tidak boleh

yang lain.

Penutup

Dengan mengucap syukur Alhamdulillah panduan membuat kamus digital fisika ini telah
selesai. Penulis yakin masih banyak kekurangan baik secara penyajian maupun isi materinya. Hal ini
dikarenakan keterbatasan penulis untuk mengungkap semua fasilitas yang disediakan oleh sebuah
software. Sehingga penulis hanya mengulas apa yang telah penulis lakukan dan menjadi sebuah

karya yang dapat dimanfaatkan oleh khalayak umum.

Kritik dan saran selalu penulis harapkan demi pengembangan selanjutnya. Semoga apa yang

telah penulis sajikan dapat bermanfaat bagi khalayak umum. Terima kasih.
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Surabaya: Dua Selaras.
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